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Summary of Improvements to the Summer Version ADI16
• Now have three color models to enhance and analyze images:
1) Red-Green-Blue,
2) Cyan-Magenta-Cyan, and
3) Hue-Saturation-Value
• Modified Colorness enhancements. Example:
Redness = Red / (Red + Green + Blue),
Yellowness = Yellow / (Cyan + Magenta + Yellow), and
Hueness = Hue / (Hue + Saturation + Value).
• Modified Color Essence enhancements. Example:
Red Essence = Red * Redness,
Yellow Essence = Yellow * Yellowness, and
Hue Essence = Hue * Hueness.
• Now there are 13 predefined color enhancements for each of the three color models
may be viewed from the Spatial, Enhancement, and Mask Windows using the
Display Menu. This allows rapid viewing, manipulation, and measurement of these
enhancements. These enhancements are also available when viewing histogram
color distribution and color along lines/paths graphs.
• May draw up to 6 spatial measurement tools on an image, and they may be exported
as a picture. . They must be the same tool – you may not change spatial tools. Can
modify measurements after other measurements are drawn. Only the
current/selected spatial tool is saved when using Save Measurements.
• May hide the colored circles of spatial tools to improve precision of spatial
measurements.
• Added “rubber band” feature when drawing paths, polygons and angles: once the
first point is created by clicking on the image, the software tracks cursor movement
and draws a line from the last point to the cursor.
• Fixed a variety of issues in the Time Series window.
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Overview of AnalyzingDigitalImages
AnalyzingDigitalImages (ADI) is a free image analysis program designed for educational
use on either PCs or Macs. The software provides integrated tools to analyze the position,
size, and color of objects in a digital picture (Figure 1).

Overview of Main Windows
Four main windows provide access to a variety of image analysis tools in this program:
Spatial Analysis, Enhance Colors, Mask Color, and Time Series.
The opening window provides access to these four windows, in addition to an example of
time series analysis, Old Growth Forests (which is used in the GSS book, A New World
View, http://www.lawrencehallofscience.org/gss/sb/newworld.html), and a general
overview of how the software works.
The Spatial Analysis window provides tools to measure the position, length, area, and
angle of objects of interest. In addition to measuring the spatial information, the colors at,
along, or within a drawn tool are measured. Analyze the colors of the original image, a
color-enhanced image, or a masked image.
The Enhance Colors window allows manipulation of the color layers of the image to
create new ways to view the color relationships in the digital image.
The Mask Color window provides tools to select pixels within selected color ranges or
having specific relationships between red, green, and/or blue intensities.
And the Time Series window provides spatial and color enhancement tools to analyze up
to 3 images in a time series in order to measure changes over time.
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Details of Main Windows
The Introduction (Opening) Window

By clicking on the Spatial Analysis, Enhance Colors, Mask Color, or Time Series icons,
you will be asked to select a picture(s) to be used in that window. You may also use the
options in the Navigation menu. Follow the steps in Open a Picture or Open Time Series
Images that are described in the following sections.
Open a Picture
(Also available in the File Menu, "Open Picture", or typing ctrl-O)
To open a picture from the opening window, click any of the top-row icons (Spatial
Analysis, Enhance Colors, or Mask Color), and the process of opening a picture stored on
the computer, memory card, CD, or DVD begins automatically.
You may also click "Open Picture" in the File menu to open a digital image any time.
Image types that may be opened include jpg (will need to rename jpeg to jpg), tiff, gif,
png, pict, pdf, or bmp.
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The following window appears to open a digital image.

Troubleshooting: If you don’t see your images, check the following:
1) Mac users: make sure the image files have the proper extensions visible (.jpg,
.png, etc.).
2) PC users: when the window opens to select your image, check the lower right
popup menu and make sure it is set to the proper image file type (for the image
below, you can only see jpegs (jpg).
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Open Time Series Images
(Also available in File Menu, "Open Time Series Images", or typing ctrl-+)
To open a picture from the opening window, click on the icon Time Series and the process
of opening the sequence of images stored on the computer, memory card, CD, or DVD
begins automatically.
You may also click "Open Time Series Images" in the File menu to open a series of digital
images any time. NOTE: If you are opening images downloaded from the USGS
Earthshots website (http://earthshots.usgs.gov/), they must be saved as 450 x 324 jpgs.
Also, the last four alphanumerics of the filename must be the year of the image. For the
example image that follows, the name is Rondonia_1986.jpg (Brazilian rain forest).
Image types that may be opened include jpg (must rename jpeg to jpg), tiff, gif, png,
pict, pdf, or bmp.
TIP: Due to time to process up to three images as once, images are limited to 1024 x 768
pixels. If your images are larger than this, use the Trim Image tool in the Utilities menu to
create smaller versions.
Options for opening time series images:
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NIR-Red-Green Satellite Images
A common image created from satellite data designed to monitor the Earth's land surface
is a false color image that maps the near infrared measurements as the image's red layer,
the red intensities as the image's green layer, and the green intensities as the image's blue
layer (if not familiar with this, see the False Colors activities in the DigitalImageBasics
software available in the DEW bundle at
http://www.lawrencehallofscience.org/gss/rev/ip/index.html).
In these images, vegetation appears red, where the redder the color, the healthier the
plant life (see example of the 1986 Brazilian rain forest from the USGS Earthshots website
that follows). Buildings and roads appear gray to light cyan, and water bodies appear
black.
ADI includes the software, VegetationAnalysis, which was used in activities in the GSS
book, A New World View, http://www.lawrencehallofscience.org/gss/sb/newworld.html);
however, now these tools may be used on a greater variety of digital images.

A false color Landsat image of the Brazilian rainforest in 1986 downloaded from the USGS
Earthshots website (http://earthshots.usgs.gov/). When saving the jpg from the website,
include the year at the last four alphanumerics of the filename. This image was named
Rondonia_1986.jpg.
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Calibrating Pixel Size (Single Image and Time Series)
After opening an image or a time series of images, you will have the option to calibrate the
size of the pixel to a known length scale. There are three options: 1) the size of the pixel is
given from the source of the image, 2) when an object of known size is visible in the
image, 3) if you are using a time series of Landsat satellite images from the USGS
Earthshots website (http://earthshots.usgs.gov/).
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Calibrate Using Option 1: Known Pixel Size
For a special type of
aerial photograph, called
an orthophotograph, and
some types of satellite
images, most commonly
Landsat, Modis, DMSP,
and IKONOS, the size of
a pixel represents a
known size of land on
the ground. An example
of an orthophoto with a
pixel size of 2 m of the
Charles River, which
separates Cambridge
and Boston, MA, follows.

To analyze spatial
relationships in this image,
click "Known Pixel Size"
and enter "2" in text box
adjacent to "Length of pixel
in image" and "m" in text
box adjacent to "Unit of
Length (2 letters)". Click
the "Done" button to begin
analyzing the image.
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Calibrate Using Option 2) Scale Present in Image
Often the size of an object visible in a
digital image is available to help
calibrate the pixel size. For example,
many digital maps include a scale
and field scientists often include a
ruler, lens cap, coin, or a person of
known height in the image. An
example of a leaf with a ruler
adjacent to it follows.

With these types of images, click the "Scale Present in Image" button in the window that
appears after you selected the image. The following window will appear to complete the
calibration.

Click and drag to create a yellow line along the ruler. After drawing the line, you may grab
either end to a new position. You may also use the red and blue arrows to reposition the
11

ends of the line. Note: the red arrows move the red end, and the blue arrows move the
blue end of the line. TIP: If you have a ruler, draw a line as long as possible, which
minimizes small errors that might occur.
If you want a completely new line, you need to go to a different location on the image to
draw a new line.
When you are satisfied with the accuracy of your line, enter the length of the line in the two
text boxes in the lower left. In this case, the line is 6 inches long. NOTE: Units of length
may be only two letters long.
TIP: You may change units from those of
the ruler. To enter centimeters, use
15.24 cm, which equals 6 in x 2.54 cm/in.
You do not need to enter whole numbers
for the length of the drawn line.
TIP: Use the line tool available in the Spatial Analysis tab panel to measure a line drawn
on the scale in the image. If the calibration process was correct, your measurements
should correspond to those of the scale.

12

Calibrate Using Option 3: USGS Earthshots Images
All USGS Earthshot images have a white square in the lower left that is used to calibrate
the pixel size. The software finds the white squares and counts the number of pixels along
each edge automatically. All you need to do is tell the software how long an edge of the
square is by typing the number and units in the text boxes located in the calibration
window that pops up.
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TIP: You don't need to
use the units provided
by the Earthshots
image. To convert the
above example of 6
miles to kilometers,
enter 9.6561 km into
the text boxes (1 mi =
1.6093 km).

Making a Mistake During Calibration
If a mistake is made during the calibration process, such as forgetting that the image could
be calibrated when opening, the calibration process can be run again using the File
Menu's "Calibrate Pixel Size" option (or typing apple-C for Macs or ctrl-C for PCs).

Opening Another Image
When opening a new image that
is a different size from the
current one, all parameters and
image storage holders are reset,
and you will be asked if the
image can be calibrated upon
opening. However, when
opening an image that is the
same size as the one that is
being replaced, you will first be
asked if you would like to keep
the same settings that you have
been working with on the current
image. These include the same
calibration factor, and any
settings for color enhancement,
mask, and spatial tools. This is
allows you to efficiently collect
measurements from a time
series of images, including
digital maps or time lapse
photos.

Clicking "Keep Settings" opens the image in the
current tab panel, if you are in the Spatial Analysis,
Color Enhancement, or Mask Colors tab panels. If
you are in a different tab panel, the image will open
in the Spatial Analysis tab panel. Clicking "Reset
Settings" opens the Calibration window.
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Color Models
Color models are numerical maps of color that help us use color efficiently: digital
photography, television, computers, vision (human and robotic), printing, painting, theater
lighting, information technology, scanners, etc. Because of the wide range of uses of
color, there are many color models. Three common color models, Red-Green-Blue, CyanMagenta-Yellow, and Hue-Saturation-Value, are available in ADI.

Red-Green-Blue Color Model
RGB is the common color model of television screens, computer screens, digital cameras,
and our eyes. It is the color model of additive color: when colors are mixed, the resulting
color is lighter than either of the separate colors. The eye is seeing two or more sources of
light. Think of sunlight going through a prism: a rainbow of colors that were present are
separated. With digital technologies, such as computers, intensity values of red, green,
and blue are integers from 0 to 255. An intensity value of 50% would be 127 on a
computer.
On a computer screen, the RGB color model may display 256 x 256 x 256, or 16.78
million, colors! But few color models can create all colors that the human eye perceives.
What colors cannot be created with the RGB color model?
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Cyan-Magenta-Yellow Color Model
CMY is often the color model used by printing technologies. It is the color model of
subtractive color: when colors are mixed, the resulting color is darker than either of the
separate colors. Remember mixing all of your paints in your paint set? The result was
something dark. The observed color depends on the color of light reflected from the
surface of the dye, pigment, or paint. The other colors are absorbed or subtracted from
the light illuminating the dye. Computer printers don’t mix the dyes before printing on
paper, but rather print small dots of varying intensities of cyan, magenta, and yellow very
close to each other. Human vision creates one color from the three colored dots.
Mixing paints is more complicated than mixing pure dyes since most paints contain a
significant volume of white paint. Adding yellow and blue paints won’t produce black, as
shown in this color model. Some of your experiences with mixing paint don’t carry over to
the world of printing.
Note that CMY intensities range from 0-1.

.
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Hue-Saturation-Value Color Model
Hue/Saturation/Value, or HSV, is a cylindrical color model that is similar to how a painter
mixes black and white to pure pigments to create color.
Hue represents color, with each value representing a distinct color along the spectrum, or
color wheel, of red-yellow-green-cyan-blue-magenta where: Red = 0%, Yellow = 16.7%,
Green = 33.3%, Cyan = 50%, Blue = 66.7%, and Magenta = 83.3%.
Saturation is the intensity of the color (0% = no color, 100% = maximum intensity of color).
Value is the range from black (0%) to white (100%).
Notice black and white can be created in many ways with this color model.

Image on right from http://infohost.nmt.edu/tcc/help/pubs/colortheory/web/hsv.html and
image on left from https://en.wikipedia.org/wiki/HSL_and_HSV.
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Spatial Analysis Window
The Spatial Analysis window allows you to measure the location and/or size of objects in
the digital image. Tools may be selected by clicking on the drop down menu labeled
"Select Spatial Tool".
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Tip: To improve precision, zoom into the image to check that the line best represents the
length of the scale.

Spatial Analysis Tools (Single Image and Time Series)
There are six spatial tools: pixel, line,
path, rectangle, and polygon, and angle.
The Time Series window provides the
pixel, line, path, rectangle, and polygon
tools, with the rectangle and polygon
tools having an additional option, NDVI
masking.
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The pixel tool shows the
location of the pixel and the
color at that location in the
image. Click anywhere in the
image, and a cross hair
appears at that location.
Along the left column of the
window, the position of the
cursor is given. NOTE: The
upper left corner of the image
has coordinates X = 0 and Y
= 0.
Use the blue arrows in the left
column to move the cursor
one pixel per click.
The color of the pixel at the
crosshairs is provided in the
left column of the window.
NOTE: the color is based on
0 to 100% intensity. A pixel
typically has color intensities
ranging from 0 to 255, but
percentages of intensity are
easier to conceptualize.
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The line tool shows the location of the end of the line (one marked blue, the other red). To
create, click and drag to create the two ends of the line.
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TIP: To maximize precision, zoom in and turn off the line circles.

Along the left column of the window, the positions of the ends of the line are given. NOTE:
The upper left corner of the image has coordinates X = 0 and Y = 0.
The length of the line, in pixels, is provided. If the image has been calibrated to a scale, the
length of the line relative to the scale is given.
Use the blue and red arrows in the left column to move the corresponding end of the line
one pixel per click. You may also click and drag an end of the line to a new location.
The average color of the pixels intersecting the line is provided in the left column of the
window. NOTE: all color measurements are based on 0 to 100% intensity. RGB color
intensities typically range from 0 to 255, and CMY and HSV range from 0 to 1.
Percentages of color intensity are easier to conceptualize for all three color models.
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The path tool shows the location line segments (the starting point is marked blue, the
others are in red). To create a path, click on the image to create straight-line segments.
To finish the path, double-click to create the last point. NOTE: the path has a limit of 75
points.

The length of the path, in pixels, is provided. If the image has been calibrated to a scale,
the length of the path relative to the scale is given. TIP: use the path tool to calculate
circumference of objects or path distances on maps.
To change the shape of the path, click and drag any corner or end of the path to a new
location. TIP: zoom and pan to check the accuracy of the path corners and ends.
The average color of the pixels intersecting the line segments of the path is provided in the
left column of the window. NOTE: all color measurements are based on 0 to 100%
intensity. RGB color intensities typically range from 0 to 255, and CMY and HSV range
from 0 to 1. Percentages of color intensity are easier to conceptualize for all three color
models.
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The rectangle tool shows the location of opposing corners of the rectangle (one marked
blue, the other red). To create, click and drag a rectangle.

Along the left column of the window, the positions of the corners are given. NOTE: The
upper left corner of the image has coordinates X = 0 and Y = 0.
The area of the rectangle, in pixels, is provided. If the image has been calibrated to a
scale, the area relative to the scale is given.
Use the blue and red arrows in the left
column to move the corresponding
corners one pixel per click. You may also
click and drag a highlighted corner to a
new location (turn on the tool circles to
see which corners may be dragged).
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The average color of the pixels within the rectangle is provided in the left column of the
window. NOTE: all color measurements are based on 0 to 100% intensity. RGB color
intensities typically range from 0 to 255, and CMY and HSV range from 0 to 1.
Percentages of color intensity are easier to conceptualize for all three color models.
The polygon tool allows you to draw irregular shapes on the image. Click the location of
each vertex. The last vertex must lie close to the starting vertex for the polygon to be
completed, so click the final point at the beginning of the polygon (which is highlighted in
blue). NOTE: the polygon has a limit of 75 vertices.

The area of the polygon, in pixels, is provided, and, if the image has been calibrated to a
scale, the area relative to the scale is given.
You may change the shape of the polygon by clicking and dragging a vertex to a new
location (turn on tool circles to help see the vertices, if needed).
The average color of the pixels within the polygon is provided in the left column of the
window. NOTE: all color measurements are based on 0 to 100% intensity. RGB color
intensities typically range from 0 to 255, and CMY and HSV range from 0 to 1.
Percentages of color intensity are easier to conceptualize for all three color models.
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The angle tool allows you to measure the angle of objects in the digital image. Click the
location of the three points that define the angle.

The angle in degrees is provided.
You may change the angle by clicking and dragging one of the vertices to a new location.

26

The Time Series window doesn't provide the masking of pixel color, but for false color
satellite images, there is one option to count pixels using the rectangle and polygon tools
within a specific range of values of Normalized Difference Vegetation Index (NDVI). These
tools are only available for false color images where the measured near infrared (NIR)
intensity is mapped as the image's red color, the measured red intensity displayed as the
image's green color, and the measured green intensity displayed as the image's blue color
(free sites for downloading these types of images are USGS Earthshots
http://earthshots.usgs.gov/ and UNH's Landsat Clic 'N Pic http://mvh.sr.unh.edu/Landsat/).

This example shows how the amount of plant cover changed on the north slope of Mt St
Helens volcano before, just after, and a nearly a decade after its dramatic eruption.
Images are from the USGS Earthshots website http://earthshots.usgs.gov/.
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Basics of NDVI
A Vegetation Index is a measure of the amount of vegetation covering the Earth's surface.
Healthy vegetation absorbs visible light, especially red and blue light, and reflects much of
the infrared. A simple Vegetation Index is based on the difference between these
intensities. Another index, NDVI, provides more consistent identification of vegetation.
"Normalized Difference Vegetation Index" means that the difference between the
intensities of the reflected near infrared and visible red light are divided by the sum of the
intensities of the two light measurements:
(NIR intensity - Red intensity) / (NIR intensity + Red intensity)
This mathematical manipulation tends to compensate for areas experiencing hazy
sunshine compared to those in clear skies, or uneven lighting conditions due to hills and
valleys.
This formula produces values between -1 and +1. Negative values are produced when the
red intensity is greater than the NIR's, and positive values are generated when the NIR
intensity is greater than the red intensity.
Dense, healthy vegetation produces NDVI values near +1.0.
Bare soil and rock reflect similar levels of infrared and red light, so these surfaces produce
NDVI values near 0.
Clouds, water, and snow reflect more visible light than infrared, which is the opposite of
vegetation, and so produce NDVI values near -1.0.
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X and Y Locations (Single Image and Time Series)
Moving the cursor, line, or rectangle with the control buttons can be confusing unless you
understand the mapping of X and Y on the image.
Say the size of an image is 451 pixels wide and 325 pixels high. The upper left corner is
(0,0).
X controls the horizontal location of the cursor, and the maximum value on the screen is
450 (0 indicates the left edge and 450 the right edge, so 451 pixels make up each row of
the image).
Y controls the vertical location of the cursor, and the value of the upper edge is where Y=0.
The lower edge has Y=324.

29

Zooming and Panning the Image (Single Image and Time Series)
The maximum size of the image that can be displayed is 640 pixels wide by 480 pixels
high for single images, 450 x 324 for time series images. This produces an image
considerably less than one megapixel, yet most digital cameras, even those on cell
phones, have many more pixels than this. In order to access the greater resolution, zoom
into the image and pan to objects of interest within the image.
To change the magnification, or zoom, click and drag the slider, click on an end of the
slider line, or type "+" to zoom in or "-" to zoom out.

When zoomed in, you must pan across
the image to see different parts of the
image. To do this, hold down the SHIFT
key while clicking on the image and
dragging in order to expose undisplayed
parts of the image or use the arrow keys
on the keyboard.

Once you reach the edge of the image,
you cannot pan in that direction any
longer. Compare the image above to the
image below - both have same
magnifications, but different parts of the
image are visible.
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Color Analysis with Spatial Analysis Tools
Five of the six spatial analysis tools provide color information of the pixels in contact or
within the drawn spatial feature (the angle tool does not measure color).
There are 13 color enhancements of the
image that may be displayed using the
Display Menu.
The color information measured with the
spatial analysis tools depends on which
image is being displayed. When an
original or enhanced image is displayed,
the colors based on those images are
used in the calculations.
When a masked image is selected, the
spatial tools count only the masked pixels
within the rectangle or polygon tools or
touching the selected line or path.
Average color is based on the masked
pixels. Pixels that haven't been masked
have been ignored.
NOTE: a pixel is masked when its color
falls within the selected color thresholds
or meets a specified color relationship
(say, the red intensity at a pixel is at least
twice as great as the blue intensity). For
the image below, the area is based on the
counted masked pixels. The number of
pixels within the rectangle is 185,058 and
its area is 25.53 in2, but the number of
masked pixels within the rectangle is
86,389, which translates to a leaf area of
11.92 in2.
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After a spatial analysis tool has been selected and the spatial feature drawn, changing the
color enhancement of the image being displayed changes the calculated color using the
drawn spatial tool, and, in the case of the masked image, the measured length or area,
since these are based on only the masked pixels.
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Enhance Colors Tab Window
Introduction
Digital images are spatially organized fields of red, green, and blue intensities. The colors
we see have a variety of meanings, but quite often there are spectral patterns too subtle
for us to notice. By enhancing the colors, we are able to observe and measure these new
patterns. ADI16 has new color enhancements that are automatically calculated for every
image opened in the software. This document explains and illustrates these
enhancements and suggests how they may be used.
Color is most often represented in a three dimensional space, such as Red-Green-Blue
(RGB) and Yellow-Magenta-Cyan (CMY), where RGB represents additive colors of light,
and CMY the subtractive colors of pigments. Many of the following ideas were influenced
by the information presented at the ColorCube.com website
(http://colorcube.com/articles/articles.htm) and explore a common enhancement used to
analyze foliage color: Greenness.

Digital images are made up of three layers of colors intensities that range from 0 to 255.
By changing how the layers are displayed, you might see new patterns that have scientific
meaning about an object's chemical or physical properties. For example, scientists at the
University of New Hampshire are studying the color enhancement of leaf images to see
whether the amount of chlorophyll in leaves produces a specific range of colors observed
in the red vs. blue, normalized image (as shown below). For more information about the
basics of digital images using the free software, DigitalImageBasics, see
http://www.lawrencehallofscience.org/gss/rev/ip/index.html.
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There are two ways to enhance the colors of a digital image: 1) use the predefined
manipulations or 2) select color ranges to be modified. To make it easier to deal with the
math of colors, the color intensities have been converted from values ranging between 0 to
255 to 0% to 100%.
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Predefined Color Enhancements
There are 13 predefined color
enhancements to view the
digital image on either the
spatial, enhancement, or mask
windows. To select one, click
on the Display Menu, use the
associated command keys, or
toggle through the
enhancements, as illustrated
on right.

Original Image is a Red-Green-Blue (RGB)
enhancement. This is the standard color
arrangement of digital images. To right is an
RGB image of three beams of light, red,
green, and blue, and how they would mix to
create other colors.

Red, Green, Blue, and Average of Color Intensities as Shades of Gray
When using a color enhancement, such as Red or Yellow, is analogous to using a pure red
or yellow filter in front of your camera lens (or eyes) or illuminating the scene with only red
or yellow light, respectively – only the intensity of that color coming from the objects in the
image. Comparing the intensities of the color cube using the Red and Yellow
enhancements (below), notice all colors between red, yellow, magenta and white contain
maximum red intensity, and all shades between white and yellow contain maximum yellow
intensity. Meaning, we should remember that showing a particular color enhancement
includes many more colors than the selected color.
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RGB of color cube.

Red enhancement of cube.

Yellow enhancement of cube.

In these color enhancements in which color intensities are converted to black and white
images, white represents maximum intensity of the color, black represents no intensity of
the color. The black and white images tend to minimize viewers’ differences in color
sensitivities. Notice that for red, an entire face of a color cube is identified as full red (this
represents the Red-Yellow-Magenta-White face of the cube). This is not true for yellow –
only the edge of the cube extending from Yellow to White. To see this more clearly, the
color faces have been filled in and then opened up to see all six faces (see the following
three images).

Faces of RBG color cube.

Red enhancement of faces.

Yellow enhancement of faces.

These enhancements display a gray shade image of only one of the color components of
the image. Gray shade images allow you to examine the intensities of values without
biasing your sensitivity to color. Most of us have variable sensitivities to color - for
example, most of us perceive green most acutely. Using shades of gray eliminates this
bias in perception so we can gauge the intensities of the separate color fields more
uniformly. If red is displayed as gray, high intensities appear white, low intensities appear
black. Below are the four enhancements of the above RGB image.

RGB

Red as Gray

Green as Gray

Blue as Gray

Average Color

NOTE: Similar enhancements are available for the other two color models: Cyan-MagentaYellow and Hue-Magenta-Cyan (except for Hue, in which saturation and value are both set
to maximum).
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Redness, Greenness, and Blueness
These enhancements provide a visual analysis of the purity of the selected color (a pure
color is when no other colors are present), regardless of color intensity (for example, a
dark red could have the same purity as a bright red). The magnitude of the color in the
name of the variable is divided by the sum of the three color intensities and converted to a
percent value. The color is shown in shades of gray, which allows ready comparison
between these three variables and to minimize the bias of people's color sensitivity.
An example of two calculations: Suppose Redness is selected. If a pixel has red, green,
and blue (RGB) values of 40%, 80%, and 60%, the redness value = 40 / (40+80+60) = 40 /
180 = 0.22. The displayed color for that pixel will be a relatively dark shade of gray (RGB
values of 22%, 22%, 22%). Compare this value to another pixel with RGB values of 10%,
10%, 0%. The redness 10 / (10+10+0), which equals 0.5. The pixel will be displayed as a
very bright green (RGB value of 50%, 50%, 50%). Below are two examples of the redness,
greenness, and blueness.

RGB

Redness

Greenness

Blueness

Viewing the color cube with these colorness values, notice white no longer contains
maximum values, but any value along the "black to color" vector is a maximum value. So,
in a sense, these values represent the purity of the color, but do not indicate the intensity
of the pure color, but will be quite useful when uneven illumination occurs (shadows).

RGB of color cube.

Redness enhancement.

Yellowness enhancement.
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Viewing the color cube with these colorness values, notice that any value along the "black
to color" vector is a maximum value (“white to color” when using Cyan-Magenta-Yellow).
So, in a sense, these values represent the pureness of the color, but the enhancement
does not indicate the intensity of the pure color. This can be seen on the colorness
enhancements of the color cube faces (redness on left; yellowness on right).
NOTE: Similar calculations/enhancements are available for the other two color models:
Cyan-Magenta-Yellow and Hue-Magenta-Cyan.

Red Essence, Green Essence, and Blue Essence
The two enhancements may be combined, say Red * Redness, which provides both a
sense of the purity of the color and the intensity of this pure value. For lack of a better
word at this time, this value will be called the Color Essence, and may be calculated for
Red, Green, Blue, Yellow, Magenta, and Cyan using the above formulas.
Red Essence = Red * Red / (Red + Green + Blue)
Yellow Essence = Yellow * Yellow / (Cyan + Magenta + Yellow)
View the color cube in these enhancements, and notice that there is greater resolution of
the selected color, being a maximum value only at pure red for Red Essence and pure
yellow for Yellow Essence.

RGB of color cube.

Red Essence enhancement. Yellow Essence enhancement.

Faces of RBG color cube.

Red Essence enhancement. Yellow Essence enhancement.

NOTE: Similar calculations/enhancements are available for the other two color models:
Cyan-Magenta-Yellow and Hue-Magenta-Cyan.
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Summary of Color, Colorness, and Color Essence Enhancements
To maximize the versatility of color analysis, the ADI16 software (the version revised in
summer 2016) includes all three categories of enhancements, presented and illustrated
above:
(1) Amount of a Color component present regardless of additional colors (impurities),
(2) Purity of a color regardless of the overall intensity (Colorness), and
(3) Combined purity and intensity of a particular color (Color Essence).
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Red vs Green, Red vs Blue, or Green vs Blue (normalized)
These enhancements provide a visual comparison between two color layers, which may
be useful for highlighting objects of a unique color or for searching for subtle color
differences within the image.
The difference between the color intensities is divided by the sum of the color intensities.
The color that is displayed is the color with the greater intensity. This enhancement is a
common technique used in examining satellite imagery because it minimizes the effects of
shadows and indirect lighting within the image. It turns out to be quite useful in observing
our everyday world with digital images.
An example of two calculations: Suppose Red vs Green (normalized) is selected. If a pixel
has red, green, and blue (RGB) values of 40%, 80%, and 60%, respectively, the difference
between red and green is 40%, with the green being the more intense color of the two. The
sum of the red and green intensities is 120%, so the normalized difference will be 40% /
120% or 0.33, which is converted back to percent values of 33% for display purposes. The
displayed color for that pixel will be a dark shade of green (RGB values of 0%, 33%, 0%).
Compare this value to another pixel with a difference between red and green of 40%, but
in this case the pixel has RGB values of 0%, 40%, 20%. The normalized difference is 40%
/ (0% + 40%), which equals 1. This value is converted back to a percentage of 100%. The
pixel will be displayed as a very bright green (RGB value of 0%, 100%, 0%).
TIP: The greater the intensity of the color displayed, the greater the relative difference
between the two colors being displayed. If the two intensities are equal, the displayed color
is black (RGB value of 0%, 0%, 0%).
Below are two examples of the normalized difference enhancements. One is of a leaf, and
the second is of the red, green, and blue light beams used in the earlier examples of the
predefined enhancements.

RGB

Red vs. Green

Red vs. Blue

Green vs. Blue

NOTE: Similar calculations/enhancements are available for the other two color models:
Cyan-Magenta-Yellow and Hue-Magenta-Cyan.
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Custom Enhancement of a Digital Image's Colors
This tool allows you to
manipulate and display pixels
that meet color thresholds you
select. Each color layer may
be manipulated separately but
with the same features, so we
will examine the effects of just
manipulating the red color
layer.
A histogram of the color intensity of the original image is plotted. A color histogram is a
graph of the frequencies of the color intensities, ranging from 0 to 255, in the digital image.
Colors are plotted in increasing intensity to the right, and the length of the vertical line
represents the relative frequency of occurrence. Notice that each line is drawn with that
color intensity–the line at the far left will be black (no red intensity), and the line at the far
right will be the brightest red. Use the color histograms to identify separate groupings of
color, since these often relate to different objects in the image. In this case, the red
histogram is for the leaf image, and the darker red grouping is found in the leaf, and the
brighter population of red is found in the white background of the image. TIP: you may
enhance an enhancement (predefined or another custom color enhancement).
To turn off a color layer (or not display it),
click the "Off" radio button. If both the
green and blue layers are clicked off, and
the full range of red colors is displayed,
the image is a red-intensity version of the
predefined enhancement, "Gray image of
Red Intensities".

Checking the Invert checkbox inverts the
selected range of a color layer, which
changes those intensities by subtracting
the value from 100%. So no intensity, or
0%, becomes 100% (100-0=100%), and
the brightest intensity, 100%, becomes
0% (100-100=0%). The red intensity
image displayed above has been inverted
is displayed on the right.
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Limiting a Color Range to be Displayed
By clicking and dragging the maximum
and/or minimum values on the color
histogram, you can select a range of color
to display. When the "Limit" radio button
is clicked, only the colors within the
selected range will be displayed. In this
case, red intensities outside this range
will be displayed with red intensity of 0%.
With the green and blue layers turned
"off" (not displayed), the image of the leaf
with displaying only red intensities
between 0 and 46% is displayed on the
right.
Since the background was near white,
which has intensities of red, green, and
blue near 100%, it now appears black
since the blue and green were turned off
and the high intensity red values were
ignored.
Stretching a Color Range to be Displayed
Stretching a range of color is similar to
the limiting method described above:
only the color within the selected color
range will be displayed. The difference is
that the color that is displayed is
stretched to fill a complete range from 0
to 100%. For the selected range of red
intensities from 0-46% will be stretched
so that the 0% remains 0%, the halfway
intensity, 46%/2 or 23% will be displayed
at 50%, and the 46% will be displayed at
100%. All values between 0 and 46% will
be linearly "stretched" in a similar way.
Compare the nearly identical settings for
the leaf shown above (limited red
intensities between 0-46% (shown above)
and that when the range from 0-46% are
stretched (shown on right).
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Combining Enhancement Features
You can combine the limit and stretch features with the invert tool. Remember, the invert
tool converts the intensity value to 100%-intensity value. For the red intensities limited to
0-46%, that range will now appear at 100-0% or 100% to 100-46% or 54%. When inverting
a stretched range of color, since the stretched values are displayed from 0-100%, the
inverted colors will also range from 0-100%. However, what was to be displayed as 0% in
the stretched image will not appear as 100-0% or 100%, and a stretched color that would
have been displayed as 100% will now be displayed as 100-100% or 0%.
TIP: To continue modifying colors of an already color-enhanced image, click the button
Use Enhanced Image as Original Image in the lower left of window.
Tip / Troubleshooting: When changing values for the Apply Custom Enhancement, the
present image being displayed will be enhanced. So you may end up enhancing an
already enhanced image. This is both powerful, but also may be confusing. Make sure
you have selected the predefined image enhancement (includes the original image) if this
is what you were intending.

Red intensities limited to 0-46% and
inverted.

Red intensities stretched from 0-46% and
inverted.
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Mask Colors Tab Panel
Similar to the Enhance Colors tab panel, the Mask Colors tab panel provides tools to
display pixels that meet color thresholds you select. However, with these masking tools,
pixels meeting the color criteria are displayed as black. White pixels represent those that
did not meet the criteria. The masked image may be used in combination with the spatial
analysis tools to count the masked pixels. Using the masked image and the spatial
analysis tools allows you to measure areas and color characteristics of irregular shaped
objects.

This masked image is available to analyze using the Spatial Window and the
Enhancement Windows using the Display menu (shown at the beginning of this section).
There are two ways to mask an image: 1) select a range of colors or 2) create a
relationship of color intensities to mask.
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Creating a Masked Image by Selecting a Range of Colors
To quickly select a range of colors, click and drag a rectangle within the object of interest
in the digital image. This minimizes the need to understand how color is created on a
computer using intensities of red, green, and blue. However, learning this color model
may help you become more intuitive in both masking and color-enhancing images. See
the activities and the free color-training software, ColorBasics, at
http://www.lawrencehallofscience.org/gss/rev/ip/index.html.

The maximum and minimum values of the red, green, and blue color layers are displayed
on the color histograms shown in the lower left of the tab panel. The color histogram is
based on the image being displayed. You may use any of the color enhancements
available in the Display menu for masking. When selecting one, the color histograms, and
the maximum and minimum values within the selected rectangle, which remains
unchanged, will be updated on the histograms. Use these to get an idea of the range and
distribution of colors in the image.
TIP: To speed up the masking process, consider turning off one or two of the colors. In the
leaf image above, leaves poorly reflect red, so this was selected and green and blue were
turned off to create the mask.
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To create a masked image, click the button labeled "Show Mask"; however, before
clicking, consider ways to speed up the masking process. Using all three criteria of color
intensities takes the longest since each of the three ranges of color must be checked. If
one or two colors may be tested, the process speeds up considerably. In the example
with the leaf, either using the spatial analysis tools or the color histograms, you could have
determined that the leaf's red, green, and blue colors were all less than the background's
colors. So only the red color thresholds will be used to create the mask of the leaf. To
turn off the green and blue tests, click the appropriate checkboxes so the checks
disappear.

In the above mask, a bit of the main stem is not masked, so expand the range of red to be
masked. Click and drag the yellow minimum line to 0% and the blue maximum line to 56%
(NOTE: the main stem is lighter than the leaf, so it has a higher red intensity). Notice that
when the maximum and/or minimum values are changed on the color histograms, the
yellow rectangle displayed on the image disappears.
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To test if the mask is adequate, use the Display menu to display the original and compare
it to the masked image. If the mask covers the object of interest, in this case, the leaf, you
should not see a change in the boundaries of the leaf in both images. Until new mask
criteria are created, the masked image is stored so it may be quickly displayed again.
Now here is the really important use of masked images – you may use the enhancement in
the Spatial Window to interact with only the black pixels. In this case, the area of the leaf
can be calculated quite precisely and efficiently – and the highlighted pixels of the ruler
area ignored when using one of the area tools (rectangle or polygon) and drawing around
only the leaf. And an added bonus, you get the color analysis of only the masked pixels
within the boundary of the area tool.
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Creating a Masked Image by Creating a Relationship of Color Intensities
As with the predefined color enhancements that compare one color layer to another, for
example, the red versus green (normalized), different patterns will appear compared to
looking at ranges of color. To create a masked image based on a relationship between
color intensities, click the button labeled "Create TEST 2 Relationship Mask" located in the
lower left corner of the tab panel.

A window appears in which you may create a mathematical relationship between two or
three color layers. NOTE: all color measurements are based on 0 to 100% intensity. RGB
color intensities typically range from 0 to 255, and CMY and HSV range from 0 to 1.
Percentages of color intensity are easier to conceptualize for all three color models.

TIP: This option takes a long time to complete the calculations for each pixel. To minimize
the time, use the "Trim Image" in the Utilities Menu to make an image so it just fills the 640
x 480 image model.
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Overview of Menus
There are eight primary menus: File, Display, Navigate, Measurements, Utilities, Save
Color Masks, Apply Color Masks, and Help. The File Menu has the basic operations to
load, and save images; calibrate pixel size' show or hide the original image; and display
color histograms. The Display menu allows selecting color enhancements of the digital
image from the Spatial, Enhancement, and Mask windows, which may be selected using
the Navigate menu. The Measurements Menu provides tools to save spatial
measurements to text files, which may then be used by spreadsheets to numerically
analyze and graph the data. The Utilities Menus allows images to be trimmed for faster
analysis and create a new image by combining multiple images. Save Color Masks and
Apply Color Masks provide efficient analysis of color-coded maps, such as those used at
the Pollen Viewer website (http://www.ncdc.noaa.gov/paleo/pollen/viewer/webviewer.html).
Finally, the Help menu provides essential information about the ADI software.

Details of Menus

File Menu
The File Menu provides has the
tools to load, and save images;
calibrate pixel size' show or hide
the original image; and display
color histograms.

Open Picture
To select a digital image that is stored on the computer, an external memory device (i.e., a
flask drive or removable hard drive), or a CD or DVD, select this tool. This function has
been described in the Intro tab panel.

Calibrate Pixel Size
To select a digital image that is stored on the computer, an external memory device (i.e., a
flask drive or removable hard drive), or a CD or DVD, select this tool. This function has
been described in the Intro tab panel.
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Save Full-Size Picture & Save Displayed Picture
Saving a picture has two main purposes: 1) include the images created/analyzed in reports
and presentations, and 2) save a manipulated/enhanced image to be analyzed with the
software since some tools aren't able to work on a "temporarily" enhanced image. This
second option requires that the save image be opened (see Open Picture function).
Save Full-Size Picture saves the modified image to the same resolution as the original. If
there are spatial measurements drawn and displayed on (there is a Hide button to turn the
spatial measurements on/off) the image, these will be saved.
Save Displayed Picture saves the modified image being displayed in the software (so
zoomed/panned, modified, spatial measurements will be saved if displayed) to the
resolution of the displayed image (maximum size possible is 640x480).
When this tool is selected, you may create a name for the image that is different from the
image used to create it (TIP: this is HIGHLY recommended), and you may change the type
and quality of the image being saved. TIP: always check the default options for the type of
file being saved since computers do not have a standard default setting.
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Show/Hide Original
Sometimes it is necessary to view both the color-enhanced or masked image and the
original image simultaneously. To create a floating original image (a floating image is one
that may be dragged around the window without disturbing other windows), click the
Show/Hide Original option. If you are using spatial analysis tools, you may draw on either
image, and the spatial tool is drawn on both images at the same time. The average color
measured with the spatial tools will be based on the enhanced/mask image, and not the
floating original image.
Close the window by clicking the small close button or selecting the Show/Hide Original
option again.
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Draw Color Histogram
When one of the area spatial analysis tools (rectangle or polygon) is used, a histogram of
the frequencies of the colors within the boundary of the drawn area and the entire image is
available by selecting " Graph Selected Colors " in the File Menu. The "dulled" colored
lines represent the frequency of colors within the complete image, and the "intensely"
colored lines represent the frequency of colors within the selected area. Hide or show
lines using the "On" buttons (which becomes "Off" when the line becomes hidden).
A color histogram is a graph of the frequencies of the color intensities, ranging from 0 to
255, but the scale of intensities on the x-axis remains 0-100%. Colors are plotted in
increasing intensity to the right, and the vertical height of the line at any point represents
the relative frequency of occurrence for the given color intensity.

The data used to create the histograms may be saved to a tab-delimited text file that may
be imported in any spreadsheet software. The frequencies for the complete image and the
selected area are saved for the corresponding color intensities. The graph may saved as
a jpg.

55

Example of the tab-delimited text file opened in Excel. Notice the columns are labeled.

Draw Color Along Line and Path
Using the Spatial Analysis line or path tools, you can explore the colors of the pixels
touching the line or path using the "Graph Selected Colors" option in the File Menu. The
graph shows which is the blue and the red end of the line or path.
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Hide or show lines using the "On" buttons (which becomes "Off" when the line becomes
hidden). Export the color data to a tab-delimited text file that may be used in many
spreadsheet programs such as Microsoft Excel.

Utilities Menu
There are two utilities that allow you to
create images that may be used in the
software. The trim options allow you to
create smaller sized images, which speed
up time-intensive analysis operations.
The second utility creates a new image
by combining images in a variety of ways.
A third utility allows you to check the color
quality of your computer display.
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Trim Image Utility
An image may be trimmed in three ways: 1)
the complete image may be subsampled
(systematically skip pixels) to make it a
smaller size, 2) the part of the image that is
displayed by using the zoom and pan tools is
saved at the resolution of the original picture
(only a portion of the original image is being
saved - useful when working with images
with known pixel size, such as satellite image
and aerial photographs), and 3) save the part
of the image being displayed at a different
resolution from the original.
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Notice that the size and left/top values change when you zoom in and pan the image. Use
this information to create the best selection of the image to keep in the trimmed image.

After clicking "Trim and Use Image", you will have a chance to calibrate the image at the
changed resolution. If you are using an image with known pixel size, you can't use the
"Known Pixel Size" option because the pixels didn't change size–rather, pixels have been
lost.
NOTE: The image has not been saved, so if you plan on using it again, save it with a
different name from the original.
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Combine Image Utility
You have three options to combine
digital images into one: 1) put two or
three different images into the color
layers of the new image, 2) subtract
one image from another, and 3)
average a selectable number of
images into one. NOTE: in all of this
options, you must use images that
are the same size and only the RedGreen-Blue color model is used.
Since digital images are made up of
three layers of color, combining two
or three images from a time
sequence of images (e.g., a time
series of maps, frames from a
movie, a time lapse series of images
with the camera on a tripod, etc.)
quickly shows change of objects in
the image. Use option 1) Use Color
Layers from Different Images to
create these types of images. TIP: If
the images have been saved as a
Gray Image of Average Intensities (a
pre-defined color enhancement),
then the unchanged parts of the
image appear black-and-white and
the parts that have changed have a
color other than gray.
Clicking option 1 opens a window to
select the images to be placed in the
color layers. In this example, the "before"
picture was placed in the red and blue
layers, and the "after" picture was placed
in the green layer. Images that appear
magenta are where a moved object
started, and the green shows where it
moved.
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Before

After

Combined

A second option subtracts images from each other,
which may be used to study the differences between
images. Compare the subtracted before and after
images of the office above to the combined image.
Once selecting this option, a series of windows allows
you to select the two images and what colors should
be subtracted and how displayed (shade of color or
gray).

This feature also creates artistic images from two images of nearly the same object(s).
Consider the image created by subtracting two images of vultures roosting in a tree.

61

The third option lets you average any number of images into one image. After selecting
the number of images, the number of images average so far and the file name of the last
picture opened is provided to help you keep track.

The image on the right is an average
of three frames from a time-lapse
sequence of a sunrise on Cape Cod.
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Check Color Quality Utility
Check Display’s Color is a visual test to see if the quality of the computer
screen/television/projector has adequate range in color reproduction to provide a
meaningful exploration of the digital image activities. The panel displays 81 color tiles of
shades of gray, red, green, blue, yellow, magenta, cyan, and brown. If all 81 color tiles are
visible, the quality of the display is adequate for the seeing subtle color differences in most
images.
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Measurements Menu

Doing research often requires collecting and then analyzing measurements, and to support
the first effort, this software strives to make collecting measurements for analysis as
efficient (and painless) as possible. So any measurement you can make with the spatial
analysis tools available in this program can be written to a tab-delimited text file, which is a
file format that allows any spreadsheet program to import. Once in a spreadsheet, the
data may be graphed and analyzed using software that is a standard in middle and high
schools (for example, Microsoft Excel or iWork's Numbers).

Save Measurement
The first time this feature is selected after the software has been opened, you will be asked
to select a file where the data will be saved. If you select an existing file, data will be
saved to the end of the file (this is called appending the data to a file). If you create new
file, a file will be created on the computer, and measurements will be saved sequentially.
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TIP: create a filename that has meaning about the data being collected. For example,
"file1" or "MyData" does not provide what data is being stored. After you have collected a
number of files of data, you don't want to open up a file to see what it contains. A file
containing leaf measurements of poison ivy might be named "PoisonIvyJuly42009".
Each measurement has additional data automatically saved. The data include:
- Filename of image currently opened
- Scaling factor based on calibration (will be set to -1 if image has not been calibrated)
- Scaling unit, if calibrated (for example, cm, km, etc.)
- Spatial analysis tool currently selected
- Spatial measurement
- Two measurements are saved
- Calibrated measurement (if not calibrated, will equal "-1")
- Measurement in pixels
- If the image being analyzed is a mask (pixels within the selected color range have
been turned black), then the area or length represented by only the masked pixels
is given in the measurement.
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- Percent of masked pixels within selected area or along selected line (will equal "1" if not a masked image)
- If pixel tool selected, all values will equal "-1"
- X and Y coordinates of measurement on the image (based on pixel location with
upper left corner having the coordinates 0, 0)
- Pixel tool: only one X/Y coordinate given, remaining pair equal -1, -1
- Line tool: X/Y given for both ends of line
- Rectangle tool: X/Y given for opposing corners of the rectangle (marked with red
and blue dots)
- Polygon tool: there are too many "corners" (vertices), so the two sets of X/Y equal
-1, -1
- Color enhancement used (one of the 15 color enhancements: 13 predefined color
enhancements plus the masked image and the custom color enhanced image).
- Color measurements associated with selected feature using the Spatial Analysis Tool
(average, maximum, minimum, and standard deviation for the red, green, and blue
values of the pixel at the cross hair of the pixel tool, pixels touching the line using the
line tool, or pixels within the selected rectangle or polygon)
NOTE: each measurement contains the same number of saved items in the same
sequence (and each item is labeled), which makes it easier to use in a spreadsheet.
In addition, you may add two additional pieces of information. You decide if they should be
numerical (say, date or time of measurement) or information (for example, location of
sample, species of leaf, etc.).
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Show Last Measurement
When you are making many measurements at one sitting, it is sometimes hard to
remember what was your last measurement. To help you, you can review what was last
saved using this feature.

New Measurement File
You might want to create different files to keep different measurements organized to make
the analysis more efficient. To save to a new measurement file, select this option and
either create a new file or select an existing one. If you do select and existing file, you will
be asked if it should be replaced. If you want to the measurements to be appended
(added to the end of the existing measurements), click "replace". If you click "cancel", you
will be asked to create or select another file.

NOTE: The above window can be misleading, but unfortunately, it cannot be changed.
Remember, you aren't replacing the existing measurement file, rather the new data will be
added to the file.
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Save Color Masks
If a time series of digital maps uses the
same colors to represent the same
numerical values, the software allows you
to efficiently analyze the time series of
maps by saving the ranges of colors
representing the maps numerical values.
For example, the maps used to show the
extent and concentration of tree species
across North America over the past
21,000 years (from the Pollen Viewer
website:
http://www.ncdc.noaa.gov/paleo/pollen/vi
ewer/webviewer.html). Using the mask
tool combined with the spatial tools
(rectangle or polygon), you can measure
the distribution of trees and ice in any
selected area of the map as the ice
sheets retreated across the continent.
NOTE: only the Red-Green-Blue color
model may be used at this time.
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Legend of Colors
(Values are percent coverage)
Light blue is ice.

Save Color Mask #
To select a range of colors to mask, click and drag a rectangle in an area with only that
color present. For ice, the color on the map is 80% red, 100% green, and 100% blue.
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To save this color for ice so it may be
used on maps from the remaining time
sequence, click "Save Color Mask 1".
A window appears to provide a name for
the color mask. Use a name that is easy
to remember how to use.

If you make a mistake on naming the
color mask or in setting the range of
colors defining the color mask, you may
change by "Replace 'name''".

Save Color Masks to File and Recall Color Masks from File
If you can't finish your analysis in one
session, you can save the mask settings
so they may be used at a later time. Click
the "Save Color Masks to File", which is
the second to last option in the Save
Color Masks menu. The first window
appears that indicates you may create a
new file or open an existing file. Opening
an existing deletes the original and saves
the new file in its place. Use the Recall
Color Masks from File to select the file to
restore the color masks during your next
session.
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Apply Color Masks
Once all of the colors used in the map have been saved as color masks, you are ready to
analyze the time sequence of maps. Remember, the mask and spatial analysis tools work
together to count the mask pixels within a selected area. So, first, select an area of
interest in the map using either the rectangle or polygon tools. In the example below, the
entire area of the digital map is selected.

Next, apply a color mask. In this case,
the area of the ice sheet across North
America will be first masked and
displayed in the Mask Colors tab panel,
then automatically calculated when going
to the Spatial Analysis tab panel.
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